User Manual for the Trout.exe
Population Modeling Software

developed by
Theodore J. Treska & Patrick J. Sullivan
Coldwater Fisheries Research Program
Department of Natural Resources
Cornell University
Ithaca, NY 14850-3001
in collaboration with
New York State Department of

Environmental Conservation

May 2005



Table of Contents

INTRODUGCTION ..ottt sttt ettt s b e s b e s e bt es s e b e b e s e e b e st es e et e nben e be st eneanenteneanen 3
A BRIEF HISTORY OF THE CROTS PROGRAM ...ccuutiiiiiiiiiiiiiieniiee ettt sttt ettt n 3
THEORETICAL MODEL STRUCTURE ........coiiiiitieee sttt sttt ettt st 5
Population DYNAMICS MOGE! ..o st te et e e e 5
LENGLN QNA WEIGRL...........ooeoiiiiiiiiieet bbb 7
BIOITIASS ...ttt bt bttt ettt A e bbbtk e Rt e R b e oAbt ARt eh e b e R £ e R e et benReebenbe Rt e be et et nnen 8
GETTING STARTED ...ccutiiiitiiietitt ettt sttt s ettt b s et et e s e b e b s e et et e s b et s s be st nsanen 10
Downloading and installing the Programmi ... 10

HOW TO USE THE PROGRAM........tittiutinitinitenttenteeie et et sieesteenteente ettt stsesteenbeeseemsesatesaeesbeenseenseennesanenseensean 10
CRECKING TRE DAIA............cceiieiieie ettt bbbt sb bt 12
RUNINING BNE MOGIE! ...ttt sttt sttt ettt st st se ettt sre e an e e e e s 14
ACCESSING OENEE DALA. ...ttt bbbt 15
SAVINIG ROSUILS..........coeeiiiii ettt e bbbt b ettt eb et be et et e 15
AT A et ettt Lot et Lot Ee Lot Re b et E e b et Ee b et Re b et Re b et ete e b et e te et et re et e ane 17
DAL FIEIIS. ...ttt ettt bt bbbt bbb 17

DAL DEIAUILS..........c.cocoeeiiiiiee ettt bbb bbbt n e e 18
MOQUBYING THE DALA. ...ttt ettt st st ae e te et 20
EXECUTING THE PROGRAM ..ottt ettt sttt sttt sttt sbe st ta sttt sbesaetesneseanens 22
WOIKEA EXAIMIPIE............cooviiiiiiiiiie ettt et 22
ADVANCED TOPICS ...t e bbb bbbt bbbt et b et et sb et st b s ee 25
SENSITIVITY ANALYSIS .eeeiutteeitteestteeiteeesteeassesesseeasesssssesssessssssssesssseesssessssssssssssssessssesssssssssessssesssessssesssses 26
CAICH ANAIYSIS ...ttt ettt sttt ettt st et s e s et et e be s Re e b e e Reen e et et e tearenreeneenee e enrn 27
PROGRAM DETALLS ..ottt ettt b ettt ab et sbe e besb et besbe et e sbeneerens 29
FORMI ..ttt et ettt e a e bbbt et s et satesbe et et eabesanenbeenbeen 32
TROUT ..ttt et et et e b ettt et ea e b e b e et emaesasesaeesaee st enteeanesunenueenneen 34
FREQUENTLY ASKED QUESTIONS ....ccccuttteiiureeeeireeeessrseeassseeeasseesassssesssssssssssssessssssssesssssssssssssssassssessnsssens 36
ACKNOWLEDGEMENTS ...ttt ettt sttt s b et sb et et et et be b et et st et te b ne e 37
CONTACT INFORMATION .. .ottt ittt ettt sttt s bt s e be st e abe b eneabesbessabensensans 37
REFERENGCES ... .ottt e h et b e et b ettt b ettt b et b e bt et e eb et et e eb et et e ebe et e abeneenea 38
APPENDIX I: STREAM CLASSIFICATION KEY ...cciiiitciieiieieseee ettt e 39



Introduction

Sound fisheries management requires reliable assessments of population abundance and
reasonable predictions of harvest. This must be done while accounting for varying levels of
fishing effort under different habitat conditions. To provide a framework for conducting
these analyses, population dynamics models are often employed to quantify the changes
in abundance while accounting for variations in survivorship, growth, and, in the case of
self-sustaining populations, reproduction. In New York State, an approach known as the
Catch Rate Oriented Trout Stocking (CROTS) program has been used for nearly three
decades to establish New York State Department of Environmental Conservation (NYSDEC)
trout stocking policies. CROTS provides guidance on the selection of streams suitable for
stocking and establishes appropriate stocking levels with the goal of providing high-quality
trout fisheries. Although the software used to run the population dynamics model that
provides the basis for CROTS stocking rates has evolved over the years, being re-written
in three different software formats, the basic elements of the model have remained
unchanged. We have written a version of the modeling software in Microsoft Visual Basic
(VB) called Trout.exe that uses data stored in a Microsoft Access database. This report is
designed to serve as a manual for that program and provides the biological and historical
background relevant to its use.

A Brief History of the CROTS Program

In order to quantify the likely catch per angler hour under different trout stocking levels
and for different stream types, NYSDEC biologist Robert Engstrom-Heg developed a
population model that predicted population abundance over time as a function of growth,
natural mortality, and angling pressure (Figure 1). The model made use of a trout
population dynamics framework as described by Clark et al. (1980) coupled with a trout
stocking formula proposed by Kelly (1965). Model predictions were used to explore
predicted population abundances under different stocking levels and in comparison to
carrying capacity as defined by habitat or stream type. With such a model, stocking levels
could be adjusted to meet the demands of fishing pressure without exceeding the
biological capacity of the ecosystem to sustain the population throughout the sport fishing
season. In addition to number stocked, data from creel censuses were used to assess
fishing pressure and angling harvest while in-stream surveys were conducted to assess
population levels of native trout and other species. To assess the carrying capacity of the
system three measures of trout ecosystem quality were developed: N — abundance
(number) of non-trout species present; H — a quantitative assessment of non-fish biotic
and abiotic habitat attributes (e.g. cover); F — the overall fertility of the stream, which
included physical and chemical attributes (Engstrom-Heg 1990). Engstrom-Heg and
Engstrom-Heg (1984) later developed this population dynamics model into two versions of
a FORTRAN program known as STREAM/SOURCE1 and 2. (Engstrom-Heg 1984) This
computer program was subsequently translated into a LOTUS worksheet format, known as
Trout 4x4, which was used for many years by NYSDEC staff to establish trout stocking



levels. We have re-written the program as an interactive Microsoft Visual Basic program
that cab be used to make predictions under a variety of management and ecosystem

scenarios.
Figure 1.

Schematic diagram of how the population dynamics model (Trout.exe) can be used in the
context of the overall CROTS program.

Catch Rate Oriented Trout Stocking

Ecosystem Electrofishing

Survey Surveys Environmental Fishery
1 l Inputs Inputs
Carrying Wild Trout
Capacity Numbers Nat. Mort, Effort,
Growth, Creel &
Stream Release
Type Rates
Predicted
Stocking Abundances,
Rates — Trout.exe | — Catch Rates,
& Biomass

a

If unfavorable, re-evaluate stocking

A

If favorable, compare to survey and
creel data, adjust as appropriate

e N

Creel Electrofishing
Surveys Survey

a



Theoretical Model Structure

Population Dynamics Model

The population dynamics employed in the Trout.exe model follows traditional fisheries
science theory (e.g. Van Den Avyle and Hayward 1999). The number of individual fish in
the population at any time f+1 can be expressed relative to the number that were
present at the previous time £, after accounting for sources of mortality such as those due
to fishing /; and other natural causes M:;

1) N, = Nt eXp(—(Ft + Mt))'

t+1
Survivorship and mortality are cumulative processes that accrue over time. These
cumulative effects are often represented as an exponential decline in the size of a cohort
over time. Changes in population abundance thus reflect the process of survivorship
S, =exp(—(F, +M,)). Actual observations on the population come in part from surveys,

which are a direct measure of abundance, and in part from catch and harvest which are
indirect measures that in effect monitor this process. The Baranov catch equation (Ricker
1975):

F
(2) Ct = E +tM (l—exp(—(Ft + Mt)))Nt’

t

represents the catch component. This equation reflects that of those fish that do not
survive (1-S), a certain fraction F/(F+My) fail to survive due to fishing, thus resulting in
the observed catch.

In sport fisheries the mortality can be further partitioned into that which is due to harvest
(creel mortality) and that which is due to the stress associated with catch and release
(handling mortality). This combined total mortality rate can be expressed (now without
showing the time specific subscript) as:

(3) F = I:Creel + F

Handling *

Both of these components reflect baseline rates corresponding to fishing pressure, creel
and poaching rates, and survival of released fish, the mechanics of which will be explored
below.

The total instantaneous fishing rate Fgsuing, Can be derived on a per day basis by using
monthly measures of effort (£) divided by the number of days per month (D). The monthly
measures of effort are calculated as proportions of the total annual fishing effort. Both the



total and the proportions per month are specified by the user in the input database.
Annual effort is measured in hours/acre based on the yearly angler pressure applied over
the entire stream reach. This daily measure of effort is then multiplied by catchability,
which may vary by stocking component, month, and year:

qE
(4) I:Fishing = E .

Each stocking event is represented as a separate component that is tracked through time
as distinct populations. These separate stocking components are combined when the
totals are finally calculated.

In order to determine the rate at which anglers remove fish, or the instantaneous creel
rate Fcree, the model requires information regarding the proportion of fish that are legal-
sized (~,) and the proportion that are sublegal-sized (1-7,), the proportion that are kept or
creeled from the legal-sized component (Px;. creel rate) and the proportion that are kept
from the sublegal-sized component (Fxs poaching rate):

(5) FCreeI = FFishing ((PKL )PL + (PK )(1 - PL )) .

Not all fish that are caught by anglers are removed from the system. Sub-legal fish are
usually released, and some anglers release legal fish (i.e. catch-and-release anglers). The
rate at which they are released A, is the difference between the instantaneous fishing rate
and the instantaneous creel rate:

(6) R=F F

Fishing ~ ' Creel *

A proportion of the fish that are released do not survive the stresses that accompany
being hooked and therefore add to total mortality. This additional mortality is represented
through the term Fuanaing- TO account for those fish that die due to this stress, we must
account for the expected release survival rate Sg:

(7) F =R(1-Sy) .

Handling

As in all biological systems, the natural mortality component (M) is a key but often
immeasurable addition to the total mortality rate. In the model, the natural mortality rate
is divided into fishing season and winter rates. Within Trout.exe, seasonal values can be
made to vary monthly, but values are usually kept constant throughout the season.

After all of these mortality rates have been determined, they are summed to produce a
daily instantaneous total mortality rate Z that determines the number of fish that survive
to the next time period. This Z is equivalent to the (F + M) term from equation (1)

(8) Z=F,,+F +M .

Handling



Length and Weight

The weight-length relationship used in the Trout.exe model is adapted from standard
weight-length relationships commonly used in fisheries science, wherein the weight is
stated as a constant times the length taken to a power (Anderson & Neumann 1996):

9 W, _=a_’.

gms mm

Historically this relationship was specified as the logio transform for the purposes of
deriving linear regression estimates:

(10) log,((Wy,s) =log,o(a) + Blog, (L) -

In this context, the power g is usually set to 3 (representing weight as volume) and the
constant « is a variable dependent on the species of fish being evaluated. For brook,
brown and rainbow trout living in streams, the « value is usually very close to 107, with a
corresponding value for log,,(«) of -5 (e.g. Schneider 2000).

Because weight-length analyses are typically carried out in millimeters and grams in the
scientific literature, two conversions are applied to convert the information to inches and
pounds (as required for communication to the public). To adjust for this, the following
transformations have been applied:

me = 25.4 L//]
Wiss = 0.0022 W/,

to obtain:

W, = @(0.0022)(25.4L,,)’ .

By inputting an « of 107, we developed the following relationship:
W, = (107)(0.0022)(25.4L,,) .

In Trout 4x4, the spreadsheet version of the model, a fraction with a large denominator is
used to represent the translation from grams to pounds and to include the coefficient « .
The resulting fraction

1

——————=(107)-(0.0022),
45454545 a07)-¢ )



is sometimes better in defining the relationship to the appropriate number of significant
digits. For this reason one might find the following equation:

_(254L,)

11 -
(11) s 45454545

in the Trout 4x4 model.

Given that hatchery fish are often heavier than wild fish of the same length, this equation
also incorporates a condition factor k = 1.1, that accounts for this difference. This
condition factor is only used in the initial weight calculation on the stocking day, making
the first day weight calculation:

_11%(25.4*L)

(12)
45454545

This initial weight information is then used to determine the daily weights and lengths of
the fish as the season progresses. Daily weights at time #+1 are calculated by using the
weight at time ¢ and a time and age dependent growth value, depending on the age (year
class) of the fish and whether the calculation is taking place during the fishing season or
over winter:

(13) W =W, * (egmwm )

Lengths are then calculated using a derivation of equation 11 and a measure of standard
deviation determined from the coefficient of variation, which is usually set at the default
value of 0.09.

(W, ¥45454545)"°

14 L =
( ) inches 254

Biomass

Daily biomass figures (B, are finally determined with a simple calculation involving the
number of fish alive at time 7, (V) and their respective average weights (W ,),where tis
day and ¢ is used here as an indicator of stocking component representing each individual
stocking group:

SC

(14) Bt = Z(N c,th,t) :

c=l1



Table 1.

List of variable definitions and their notations in both Engstrom-Heg (Engstrom-

Heg, R. 1991) and this report.
*Note: some of the report definitions correspond to vectors in the program and therefore do not have a
matching definition in Engstrom-Heg

Used Here Engstrom-Heg Definition

N Number of fish present

F Fishing mortality

M zn Natural mortality rate

Frishing zfl Daily instantaneous total fishing rate

q c Catchability figure

E Effort (monthly percentage of total)

Fcreel zf Instantaneous creel mortality rate

Pk Proportion of legal-sized fish that are kept (creel rate)

Pks Proportion of sublegal-sized fish that are kept (poaching
rate)

P PC Proportion of population that is legal-sized
(length > size limit)

R Zr Rate at which fish are released

FHandiing Zh Instantaneous mortality due to handling

SR Expected release survival rate (hooking survival)

Z Zt Total mortality rate (Fcreel + FHanding + M)

w Weight of average fish (in pounds)

B Total daily biomass



Getting Started

Downloading and installing the program

To facilitate access to and use of this program, a website has been developed from which
interested parties can download the program, access the documentation, and query
software support. To access this material go to the Coldwater Fisheries Research Program
website:

http://www.dnr.cornell.edu/pjs31/Coldwater/ColdwaterFisheries.htm

Click on the “Trout Setup Zip File” located at the site to download Trout.exe and the
associated support files. An “unzipping” program or software (PowerArchiver, WinZip, etc)
will be necessary to extract these files to a usable form on the computer. Using this
program extract these files to a location on your computer where you wish to save this
data. The zip file contains the Trout.exe set up executable file along with necessary
support files, an example Access database (CROTS Example.mdb), a folder containing
general stream type databases, and an Excel file (CROTS_ConvertToExcel.xls) containing a
macro to convert saved Trout.exe text outputs into manageable Excel workbooks. From
this location, you can also download or view this document that details installation and use
of the model and a Sensitivity Analysis of the model parameters.

Web sites for free ware compression and Zip software:
http://www.powerarchiver.com/

http://www.winzip.com/
http://www.thefreesite.com/Free_Software/Unzipping_compression_freeware/

From your own computer, open the folder containing Trout.exe on your hard drive and
then double click the Setup.exe file. By following the installation instructions that appear,
you will be able to change program attributes such as the installation directory. By default
the program will install itself under the Program files of the Start menu, although you can
direct it to another location during the installation.

How to use the program

Once the Trout.exe program and associated files have been installed you may select the
Trout heading from under Program files and then click on the Trout.exe accompanied by

the icon e and the following window will open, asking for a data file to use for
modeling:
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http://www.dnr.cornell.edu/pjs31/Coldwater/ColdwaterFisheries.htm
http://www.powerarchiver.com/
http://www.winzip.com/
http://www.thefreesite.com/Free_Software/Unzipping_compression_freeware/

Please Select a Data File.

Look if: IE} Fegion 9 Jos Evans ;! & = Ef-
I_;b [C)Beaver Meadow Creek Shs  [)Forks Creek Shs
4 [CiBuffalo Creek Shs [ChGoose Creek Shs
My Recent () California Hollow aspz |hHaskell Creek ebp
Dacuments [ Cass Fun Shs IC3Hunk Creek bs
@ [ Cattaraugus Creek Sasp2 [0 Ischua Creek 6bp
- [J)Cazenovia Creek 6bp [CLitkle BuFfalo Creek 6bp
Desktop [CJ)Chataugua Creek 6bp [ChMansfield Creek. as
o [C31Chenunda Creek Shs [C0atka Creek as
‘j [ Clear Creek as [C)Red House Brook, bp
My Ijoc:uments () Crvder Creek Shs [CTrib 17 of Red House bs
[J)East Koy Creek 9aspz [Cywiscoy Creek. as
el [C)Elkan Creek Shs
E! [J)Fenton Brook Yasp2

ty Computer

m,

File name: I Ll Open I
My Network  Files of type: |Access Database Files [*.mdb) ~| Cancel I

Pl
aess [~ Open as read-only
.

After selecting a file (for ease, select example file included in zip file), the following screen
will appear after which you need only press Calculate to show the default model
prediction of population levels.
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Checking the Data

Enter or modify data by using the drop-down menu in the upper right corner of the active
window. Select the appropriate heading to view the data contained within this file.

|STDCkin9 Data j Maozimum Biomass L

Component Fear manth day| mumber| 1ength Ci

[ 4 1 k& 1 i 2.5 .04
2 1 5 1 43 9,25 0,09

1 1 4 15 a4 3 0,09

3 1 E 1 175 2.5 0,09

When the stocking data has been entered, the next step to select the appropriate stream
type and effort distribution which will set the natural mortality value and indicate how to
distribute the yearly fishing effort in the heading Season Data (found under the drop-down
with Stocking Data). If more specific data than the baselines associated with stream type
and fishing patterns is available, from previous studies or creel surveys, this information
can be entered by selecting the “Other (Input Required)” option in either of the fields.
When this option is selected, the field heading in the drop-down menu will change to show
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the grid of the particular input that is affected by that decision, natural mortality (ZN) for
the Stream Type selection and effort per month for Fishing Pattern.

|ZN ﬂ Maoximum Biomozz (20 637 [rate W
Fear|Componen Seamorn Tinter -
2 |Stock 1 0,00z 0,004 i
1|Stock 1 0,00z 0,004 S
> g |stack 2 0.002 0,004
1|Stack 2 0,00z 0.004
2|Stock 3 0,00z 0.004
1|Stock 3 0,002 0,004 i
Fizhing Pattern Stream Type
[ Pattern 1 (¢ Type A [As, Azp etc)
(* pattern 2 " Type B (Bs. Ep)
" Other (Input Required) (" Other (Input Required)

After reviewing the data, indicate whether you want the program to calculate results by
age classes or by stocking increments (cohorts) with their associated totals by selecting
one of the two designated option buttons in the upper left. This calculation option can be
changed at any time during the execution of program. The Age Classes option returns
results organized as groups by age, for instance, all stocked fish will be considered
yearlings and wild fish will be considered separate populations. The Cohorts/Totals
selection reports results for each of the individual stocking components and the
corresponding totals.

ma Catch Rate Oriented Trout Stocking Model

File Help
o

Caloulate | Erowsze | Sove | End |

Datobaze:  |Co\Documents and
Settingzytjt ¥\ Deshtopt CRO TS, TedzDefoult.mdb

Perform Calcualtions By
Fopulation Size - Age Closzes -
Coharts/Tatals 0

Report

Age Classes, Cohorts/Totals H
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If graphical outputs are not logical in the situation that you request, such as weights by
age classes, the program will instruct you to select a new option, usually Cohorts/Totals.
Actual numbers and rates for individual cohorts and totals are available by clicking on the
Report button located just below the option buttons. By clicking this button again, you
can switch back to the graphical output, an option available at anytime.

Running the Program

To see model results, click the Calculate button in the upper left hand corner of the
window. The default setting of the program shows the graphical representation of the
population projections similar to that shown below.

: Catch Rate Oriented Trout Stocking Model E@@

File Help
r

Gz | End | Stacking bata | Maximum Biomesz [37 229 Date |1 May
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3 17 ] [ 0.03
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1
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4
3
2
1
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" Pattern 2 " Type B (Bs. Bp)
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S
5
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=
o
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<
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e
E 50+ — Total
=
Zz
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- o o ” o " -

Day

Modification of the settings in the program to change the content and format of the
outputs is straightforward. The "Graph” and “Report” settings can be switched through
the use of the toggle button below the Age Classes and Cohorts/Totals options. When
you modify any of the input parameters, you must always press the Calculate button to
recalculate the outputs, more on this later. When changing the options (Age Classes and
Cohorts/Totals), the program will automatically recalculate the results. Use the drop-
down menu in the upper left side of the window (showing “Population Size" in the above
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figure) to select among alternate output headings. This drop-down menu may also be
operated with a scrollbar. A list of possible outputs available on the drop-down menu can
be found in Table 2 below.

Table 2.
List of outputs available under drop-down menu in upper left corner

Population Size Biomass Total Catch
Catch/Hour Catch Biomass Creeled Catch
Creeled Catch/Hour Released Catch Released Catch/Hour
Average Creeled Length Average Creeled Weight Length

Weight Ft Zt

Fc Release Rate Fh

Zn Surv Prop. of fish dying
Fmort Probability of Catch

e Remember to click the Calculate button to re-compute
population predictions after changing table inputs.

Accessing Other Data

The Browse button in the upper left hand corner can be selected to determine which
stream database file is to be used. The window that appears is identical to the one that
appeared when you began the program, so all you need to do is browse to find the
appropriate Microsoft Access database file (.mdb), then double click the file corresponding
to your particular stream of interest. If a database has not yet been created for the
stream you are interested in, see the Data section below for information on developing
one.

Saving Results

When you click on the Save button at the top of the form, the program will ask whether
you would like to save the graphical output or report format. Depending on the chosen
alternative, the program will allow you to save the data in either a Notepad file (report
format) or a Bitmap *.bmp, Metafile *.mtf, or Jpeg *.jpg file (graphical output format).
Another option is to use the screen capture feature that will copy the screen that is
displayed, then paste it as an image onto the clipboard. This is done by pressing the
PrintScrn key, located near F12, usually above Home and Insert keys on your keyboard.
This will copy the screen image to the clipboard and then you can paste it into a document
(e.g. MS Word). After this, you can use the Crop function on the Picture toolbar to trim
the full screen image to the desired size. Keep in mind that only graphs of the currently
selected heading will be saved.
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To save the full report output, containing tabular data from a variety of rates and figures
ranging from population numbers to lengths and weights, answer “No” when asked if you
want to save the graphical output, thus indicating you wish to save the report format.
This then saves a compiled list of these headings into a text file (.txt) which you can
name.

Viewing Outputs in Excel

To view the data in a comprehensible and manageable setting, open either the
CROTS ConvertToExcel v2003.xls or CROTS ConvertToExcel v97&2000.x/s file using
Microsoft Excel. Choose the file version that corresponds to the version of Excel that you
are running, and when in doubt choose the earlier version, newer versions of Excel can
work with older formats, but not vice versa. Depending on the security setting of your
system, it may tell you that your security setting does not allow you to open macros like
the one in this file. To change the security setting of Excel, select Macro from the Tools
drop-down and then select Security from the list. When given the choice of settings,

select the Medium security level. This will tell your computer to always ask for permission
before opening any macros that might be of questionable origin. After opening the file,
which should contain a blank spreadsheet, the program will ask if you would like to enable
macros. To convert the text file you have saved using Trout.exe to a usable Excel
workbook, you must enable the macro. Now, execute the macro by either using the
keyboard shortcut, Control + t, or by using the Macro selection under Tools and then
select Macros. When a list of macros appears (containing only one option), select
CROTSTextConverter and then click Run. Either way, the macro will then open a dialog
box asking you to select the desired input text file that you created in Trout.exe. After
you select the file, the macro will manipulate the data and create a workbook with
worksheets corresponding to different output headings from Trout.exe. In order to create
this workbook, the macro creates a page with all the original data from the text file called
“Base” which contains all data and used this to create the subsequent pages. Pages with
titles containing “rel” correspond to release for space conservation (i.e. rel per hr =
released # per hour). The top three lines of each worksheet contain data pertaining to
the file, time and data of text file creation, database name (.mdb) and heading titles.
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Data

The following data are required to compute predictions of population abundance and
catch: 1) the timing and level of stocking, including date, number/acre, and average
length of stocked fish; 2) the timing and level of fishing effort; 3) release rate; and 4)
population dynamics parameters (natural mortality and growth) associated with a given
stream type. Default settings are provided based upon the stream type selected.

Data Fields

The following provides a more detailed description of the input data fields. Input data for
the model can be manipulated in either the Access (database) environment or directly
through the program itself by inputting them into the grid in the upper right hand corner.
If you wish to add trout populations to the data file such as wild or stocked components,
these must be added in the Access environment. Keep in mind that changes made to the
data during the execution of the program will also be saved to the database.

The input data fields discussed correspond with the data tables in the Access database
which controls the model output. These appear in the upper right hand corner of the
window, and are controlled by the drop-down menu just above the data grid. By selecting
different headings, the program will display the corresponding input data grid with the
information for that heading, allowing for changes to be made.

Stocking Data: This field provides information on the timing and level of stocking events.
These data include the date(s) that fish were stocked, the number of fish stocked per
acre, and a mean and coefficient of variation for lengths of stocked fish. If the coefficient
of variation is unknown, the parameter is typically set to a value of 0.09.

Wild Data: Contains information regarding the numbers of wild trout collected within
electroshocking surveys. These data are similar to stocking data in that date, numbers and
lengths are required. The program uses this information to estimate the abundance of
wild trout present throughout the season by back calculating from fall numbers to account
for the number of fish that are creeled and die due to a natural mortality figure given in
the data file. To be sure that the wild fish have influences on outputs, make sure to check
that values pertaining to wild components such as catchability and natural mortality are
set at appropriate values.

Season Data: Fishery parameters, such as fishing intensity (in units of yearly hours per
acre of fishing effort), the time span over which the user wants to evaluate model
predictions, regulatory size limits (if present), and an estimate of release survival. Release
survival is the proportion of fish released by anglers that survive. If you would like to
model a situation representing a “no-kill” area, enter 1000 into the size limit, keeping in
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mind that the illegal harvest rate (PKS) and release survival will have substantial impacts
on the outputs of the model in this scenario.

Effort/Month: The monthly distribution of yearly fishing effort during the sport fishing
season. Each value is the proportion of the effort that is expended in that month. These
values are usually chosen from the set of values defined by trends categorized as pattern
1 or 2, with the patterns being defined as follows: Pattern 1: April fishing accounts for less
than 40% of the total fishing effort, and at least 20% of the fishing occurs after July 1,
Pattern 2: Fishing effort is more concentrated during the early part of the season. (pg.7
Engstrom-Heg 1990) Pattern 2 is the most commonly observed distribution of fishing
effort in New York streams. See the Data Defaults section below for values of monthly
effort distributions of these patterns. These two patterns can be specified by choosing the
corresponding button below the data grid.

Harvest Rate or PKL (Proportion of legal catch kept): Represents the amount of catch and
release occurring within the fishery. This can also be thought of as the creel rate, the
likelihood that an angler will remove a legal trout that caught. These values are broken
into monthly values of the proportion of fish creeled by anglers.

lllegal Harvest Rate or PKS (Proportion of sub-legal catch kept): Represents the amount
of poaching that occurs within a stream (applicable only in streams where a minimum size
limit is imposed). Monthly values corresponding to the proportion of sub-legal sized fish
creeled by anglers are entered into this table.

Zn (Natural Mortality): Natural mortality is a highly variable rate that can change over
time and for this reason, this parameter is both component and age specific. There is
also a column for differentiating between in-season and winter mortality rates of the
components. Values in this table must be provided as daily rates. Stream type specific
values can set by using the option buttons below the data grid.

Growth: Like natural mortality, growth is separated by year and component along with
season and winter columns. The winter growth rate is set for the whole winter season,
usually to a rate of 1.04, meaning that the fish will be 4% larger on April 1% than they
were on Oct 15 when the season ended. Wild growth rates can also be entered, allowing
for differences between wild and stocked components.

Catchability (q): As a fish ages it often becomes more difficult to catch, thus reducing its
catchability. The catchability data field takes into account the age of the fish, accounting
for this fact by allowing differing rates for yearling and older fish, based on a monthly
value.

Data Defaults

The data contained in the table below is a generalized form of the default values derived
by Engstrom-Heg for the three main stream types. For more detailed stream types and
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their corresponding parameters, including those with length regulations, see Appendix | at
the end of this manual explaining each stream type. Predictions for the month of October
are now possible under the current model formulation, but default values for this month
have not yet been established. As a result empty data cells exist for October. Changes are
yet to be made as to how to distribute weights such as catchability and effort to

accommodate the season which now runs until October 15%.

Table 3.

Default values for mortality and growth of stream types along with patterns of fishing

effort and catchability, and coefficient of variation for length measurements.

Stream Type Natural Growth Rate | Growth Rate Winter
Mortality 1% Year 2" Year Growth
(Zn) Rate
Bp .004 .002 .001 1.04
Bs .004 .004 .0025 1.04
As and As9 .002 .004 .0025 1.04
As length limit .002 .005 .003 1.04
> 10"
Awp .004 .002 .001 1.04
Fishing patterns of monthly effort
Month Pattern 1 Pattern 2
April 0.350 0.493
May 0.219 0.273
June 0.158 0.094
July 0.107 0.055
August 0.095 0.045
September 0.069 0.041
Oct (unti/ Oct 15) | 0.0 0.0
Catchability
Month Year 1 Year 2
April 0.00537 0.00495
May 0.01030 0.00759
June 0.00838 0.00529
July 0.00538 0.00529
August 0.00618 0.00529
September 0.00618 0.00529
Oct (unti/ Oct 15) | 0.0 0.0

Coefficient of variation for length = 0.09
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Modifying the Data

There are two simple ways to modify the data that is used to run the Trout.exe program,
one way is to change the data in the data grid of the program and the other is by opening
the database itself in Microsoft Access.

Modifying Data Within the Program

To change data while the program is open is very simple. First, select the heading of the
data that you wish to change from the drop-down menu to display the appropriate data
set. Next, click in the cell that contains the data that you would like to modify and make
your changes. Continue this process until all the data has been appropriately modified
and then make sure that the symbol in the first row of the selected data grid looks like this
», rather than a symbol of a pencil writing. The arrow symbol indicates that the data has
been saved. If the pencil icon is still visible when the Calculate button is selected, that cell
of new data will not be used, so make sure to save it. You can also select another heading
from the list to ensure that all changes have been saved.

|51':"3kin9 Crata, j Maximum Biomass £3.172 Date 23 Alg
Conponent Fear montzh dayr| number| length chr Data not Saved
E] 2 L 22 1] 1] 0.09
& 4 z 3 17 17 i 003
2 1 B 23 34 9 0.0
1 1 4 19 1 a 0.09
|51':"3kin9 Data j Maximum Biomass Ca e Date |23 Aug
Component Tear month day| nuamber| length ci Data IS Sa.ved
; : o : =2 | and will be used
4 2 [ 17 1] 1] 0.0
[ Z 1 c 23 3¢ E 003
1 1 4 13 1 2 .03

Modifying Data in Microsoft Access

The easiest way to create a new stream database file is to copy and rename an existing
file and make the necessary changes to this new file. You can usually alleviate some work
by copying a file associated with a stream type similar to that which you are creating since
much of the data will remain the same. Upon opening a file, you may be presented with
this message from Access:
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Microsoft Access

You can't make changes to the database objects in the database "Datka Creek ID 1537 as 01.'
i i This database was created in an earlier version of Microsoft Access.

To convert this database to the current version of Microsoft Access, cose the database, poink to Database Utilities
on the Tools menu, and then click Convert Database.

6]4 |

Do not worry. While it says you cannot change the database, this only means you are not
allowed to change the data structure. The individual data components can, in fact, be
changed and saved. You may be asked to convert to the newer version of Microsoft
Access, but this it not necessary. The program can import Access 1997 and newer data
files without a problem.
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Executing the Program
Worked example

What follows is an example of how to use Trout.exe to make predictions from data that
may be contained in a standard CROTS datasheet (as shown down below).

1. Using the Stream-type indicator, as identified by the description near the [AJon
the sample CROTS datasheet below, we can find the appropriate default parameters
corresponding to that stream type as found in the data defaults in the Data section of this
manual. For the following example using stream type As, these values are:

Stream Type | Natural Growth Rate | Growth Rate | Winter
Mortality 1% Year 2" Year Growth
(Zn) Rate
As .002 .004 .0025 1.04

These data are used in the “Natural Mortality” and “Growth” data fields, although natural
mortality can be set using the radio buttons corresponding to Stream Type in the upper
right corner.

2. The fishing pressure (intensity) that the stream receives is found on the form near

the [B), and is inputted into the “Season Data” grid. This is also the grid that allows you
to specify the time period over which you want the population modeled, any size limit
regulation and the expected release survival rate (usually set to 0.9). In this example, our
intensity is 175 hrs/acre.

3. Most streams in New York receive the bulk of

the fishing pressure early in the season, soon after the Month Pattern 2
fish are stocked, and hence most of the streams are | Apri/ 493
classified as Pattern 2 fisheries, with a skewed | May 273
distribution of effort. In our example, the given | June .094

stream is indicated to be Pattern 2, as denoted near | July .055

the [ 6 ), so we enter data corresponding to pattern 2 | AUgust .045

from the Data section into the grid with the heading | September .041
“Effort/Month” or select the Pattern 2 radio button. Oct (until Oct 15)

4. The “Stocking Data” table is one of the most important fields in the model, storing

the number, size and release date of stocked fish. Individual stocking events are denoted

in the first table on the CROTS datasheet as indicated by the [ D). The information is
entered in much the same way as it appears on the data sheet, with the first increment
being the earliest stocking event and the data for each event having its own separate row
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as seen below. It is not essential, but it makes it easier to follow in the results if you enter
the first stocking in the row labeled Component 1 and so on.

|51':"3kir'9 Dafa j Miciel i Blgmassd - © Date 23 Aug
Component Fear month day| number| length Cir
] z E 22 1] 1] 0.0%
4 z E 17 1] 1] 0,09
3 z 1 L 23 Ex] 9 .09
1 1 4 19 71 g 0.09
5. Catchability is often hard to | Month Year 1 Year 2
estimate and for this reason, these | April .00537 .00495
values of are not often changed from | May .01030 .00759
stream to stream. In the default | June .00838 .00529
data, these values differ for yearlings | July .00538 .00529
versus older fish, and vary by month. | Aygust .00618 .00529
September .00618 .00529
Oct (until Oct 15)
6. One of the hardest things to determine about a fishery is the rate at which anglers

release fish, being that creel surveys are very time and resource intensive. This being
said, it is often the biologists best reasonable estimate that is used for values in the
Harvest Rate or PKL (proportion of legal-sized catch kept) and lllegal Harvest Rate or PKS
(proportion of sublegal-sized catch kept) tables. Obviously, if there is no length size limit,
the lllegal Harvest Rate parameters are all set to 0O, for all fish are of legal size.

7. Finally, if it is desired to model the effects of wild fish on the system and there is
data concerning numbers seen in electrofishing surveys, this data can be entered in much
the same way as the stocked data. All that is needed is the number of fish encountered,
their average sizes and the day the survey was completed. The model will then back-
calculate to the beginning of the modeling period and introduce the expected amount of
wild fish that would have been present to produce the numbers seen in the survey after
the dynamics of the season have taken their toll.

**The following page is a copy of the CROTS datasheet with example data and the
symbols representing the data described above.
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CROTS EVALUATION DATASHEET  Date

STREAM INFORMATION
Stream Name _Fall Creek Watershed ID #
Line ID (from stocking Book) 1254 CROTS Management Type As

Fishing Pattern (1 or Z)AZA[ l: ]

Fishing Intensity (hr/acre)

10 / 15 / 03 Filled out by:

T Treska

Mouth to Ithaca Falls

175

(AL
(B]

Confidence in Intensity Estimate (Circle one) High Med Low

STOCKING INFORMATION
Increment Speci Month D Y # Stocked /A Mean cv
Number pecies on ay ear ocked /Acre Length
1 BT 4 19 00 71 8.0 [ n ]
1 BT 5 23 00 34 9.0 [ n ]
POPULATION ESTIMATES
SurveyDate 8 / 26 / 2000 SWDB Survey # 700916

Estimation Method (circle): Delury, Peterson, Zippin, Projection, Leslie, Efficiency [%

Other

Were stocking rates similar the three years prior to this survey? Add comments if needed:

Wild/ | Holdover Age Mean 4 I Acre Stgrrlrd:rrd Confidence in Estimate
Species Hatchery | (Y or N) Length (If Known) (High, Med, Low)
BT H N 1+ 10.4 42.1 High
BT H Y 2 12.6 10.1 High
RT w 2 11.8 4.2 High
Comments:
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Advanced Topics

Methods for checking assumptions

Two means of testing a model should be employed when evaluating it for use. One way is
to examine how it performs with known inputs and outputs from a similarly coded
simulation model. If the model doesn’t work well for a known (albeit simulated) population
then it is unlikely to work well in practice. Once it is shown to work well in the “lab” it is
then just as important to test it in the field. Given known initial population sizes available
from the stocking data, one should be able to use fall electroshocking surveys to
determine how well the model is approximating the dynamics of the stocked population.
With the Trout.exe program this can be done by plotting the resulting population curve
computed for a particular stocking level and stream type and then identifying the location
on the plot of the observed survey abundance for the appropriate date. Figure 2 shows
the application of this method to the model output of Mansfield Creek in Region 9 for the
season of 1997. The point represents the number of stocked yearlings seen in the fall
depletion survey estimates.
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Figure 2.
Population curve and survey point data for trout numbers in Mansfield Creek Region 9,
1997
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Point represents survey results for number of stocked yearlings found on September 4.
Model prediction = 33.4, Survey estimate = 39

As we can see in this example the program has done a reasonably good job at modeling
the dynamics of the system with the given parameter inputs, but this might not always be
the case. One might also wish to run the data with varying parameter sets to test if other
combinations will give similar or better predictions, or to see what effect changes might
have on the population’s dynamics.

Sensitivity Analysis

Sensitivity analyses can be used with data created by the model, most often by using a
statistics package with graphical capabilities to explore the effects that changes to the
fishery might have on the population or rates. Changes in the stocking number or
schedule can be examined to determine how best to sustain the desired fishery, or
changes in length regulations can be implemented to see how they will affect size
distributions and numbers.

Below is a look at how by varying the release rate of trout by anglers, we can see how this
affects the population numbers of the trout in the system. By plotting the actual survey
number seen in the fall, a comparison can be made between the release rate predicted by
the model and the estimate of release rate used by biologists. Of course, other
parameters and their estimates must be taken into account when looking at these types of
data, but exploratory analyses made in this way can introduce ideas that may go on to
explain some of the uncertainty and trends that are being seen in a system. In this
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particular stream, the model and the corresponding survey data indicate that the release
rate my be as high as 50%, which is not unthinkable if the stream is one that receives
mainly catch and release pressure. If this is not the case though, you may want to take a
look at some of the other parameters and see if other estimates may provide explanation
as to why this rate is so high.

The figure displayed below was generated by running the program with varying release
rates, each time saving the population report data, and then pasting the corresponding
report format of the population levels into a graphing spreadsheet application (e.g.
Microsoft Excel). By plotting these population levels at varying release rates and then
superimposing the survey result at the appropriate location, we can see how different
parameter inputs might affect the dynamics of the system and the predictions of the
model. This representation assumes that all other parameter values are correct.

Figure 3. Population trends for Hunt Creek over the season of 2000 with varying harvest
rates. Point at lower right indicates fall electrofishing survey estimate.
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Catch Analysis

Another important rate of concern to fisheries managers is the catch rate and number of
fish caught by anglers on a particular stream. The Trout.exe model can create figures on
both these important statistics, reporting them in catch per hour and number of fish
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caught by day. Catch per hour is of special interest in that it is an indicator measuring one
of the important objectives of the CROTS program, specifically quantifying whether we are
achieving an sustained catch rate of 0.5 fish per hour on streams type A quality streams
for the length of the season and the same rate for a type B, but only for the early part of
the season.

By plotting the catch per hour and overlaying a line across the plot at catch equal to 0.5,
we can see how well the number and timing of stocking events will accommodate this
goal.

Figure 4. Plot of Catch per hour, with goal of 0.5 fish/hour line overlain
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In addition to catch rate, it is also interesting to look at the daily number of fish being
caught on the stream. By selecting the Total Catch from the output headings, we can
view a plot of what the pattern of angler success may look like given the inputted stream
parameters. In the graph below, we can see the influence of a Pattern 2 type effort
distribution, with quickly decreasing catches punctuated by drastic increases representing
stocking events over the first few months of the season. Soon after the initial surge of
fishing pressure subsides, usually around June, the catch falls back to reduced levels.
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Figure 5. Total catch plot representing changes in monthly catch rates
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Program Details

The following is a section that may be of most help to those who are familiar with
programming code (namely Visual Basic 6.0), but may also be of interest to those that are
not. The flow chart chronologically follows the execution of the program.

The following few pages are a flow chart representing the execution of the program,
followed by a list of program procedures in the order that they appear in the actual code.
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Flow Chart for
Trout.exe

Start the program
(Form Load)

A 4

Access database

User locates data file *.madb

Browse -Season data
-Stock & wild fish
A -Growth. mortality
Fill the

data grid

Perform calculations and "
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Change

Data Inputs
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Save the graphical
form of data?

Yes No

Give user choice of file Save as ASCII text file
type and save (.txt)

(.emf, .wmf, .bmp, or .jpg)

At this point the user may
choose to select a new

data heading, load a new
file, or end the program

End
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Form1

Private Sub about Click()
-determines what happens when the "About" button is clicked in the "Help" drop-down
menu, contains contact information concerning the VB model.

Private Sub Combol_Click()

-dictates what happens when the drop-down menu corresponding to Stocking and Season
data grid is utilized, sets column widths and table headings. Located in the upper right
corner.

Private Sub ComboZ2 Click()

-drop-down menu concerning what data is of interest to the user, population number,
catch rate, etc...Calls Public Sub Fill_output_grid generate reports and plots of the selected
data. Also calls Public Sub get_biomass. Located in the upper left corner.

Private Sub Commandl_Click()

-the majority of the calculations are performed in this procedure, all based on the original
Trout 4x4, creating all the pertinent data that is used and displayed by the program.
Calculations are done on a daily basis, with accommodations being made to account for
changes that occur during the modeling period, such as winter rates, changing values for
different months, etc. There are separate loops for dealing with wild and stocked
components. Calls Public Sub getseasoninfo and Public Sub Proc_Read_db_new.

Private Sub Command2_Click()
-dictates what happens when the “Browse” button is clicked. Brings up file selection
window for the user. Calls Private Sub Combo2_Click().

Private Sub Command3_Click()

-dictates action for click of Save button, which saves tabular format (report) or graphical
output of selected data in combo box2, the drop-down menu on the left. Report is saved
in a Notepad file, while graphical results are saved as *.bmp, *.wmf, *emf, or *.jpg files.
Does this by calling Public Sub Proc_save data.

Private Sub Command5_Click()
-this is the toggle button that allows the user to switch back and forth between the report
and the graphical representation of the selected data.

Private Sub DBGrid1_KeyPress
-allows the user to move the cursor around the data grid in the upper right hand corner by
using the “Enter” key.
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Private Sub Form _Load()
-this loads the program itself, sets up combo buttons (drop-down menus).

Private Sub Help2 Click()
-dictates what happens when the “Help” selection is made from the Help menu.

Private Sub Optionl_Click() Private Sub Option2 _Click()
-makes sure that only one of the selections from Year Classes or Totals can be selected.

Private Sub Command4_Click()
-dictates the actions that follow the click of the “End” button. Ends the program.

Private Sub end_Click()
-actions for the “End” selection from under the File menu. Ends the program.

Private Sub open_Click()
-actions for the “Open” selection from under the File menu, allows the user to open a data
file for use. Calls Command2_Click

Private Sub save Click()

-actions for the “Save” selection from under the File menu, allows the user to save data
from the model. Calls Command3_Click
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Trout

Function Func_FileExists
-takes in a file name string and performs a series of checks to determine whether or not it
is a viable data file.

Public Function jday
-takes in year, month and day and determines the julian day number of that day for use in
tracking daily figures throughout the program.

Public Sub Fill _output grid

-takes in a data array, number of stocked components and wild components, season start
day, and start year. Formats and fills flexgrid (report) with data in the array and then
calls the appropriate plotting procedure depending on the type of data that is being
analyzed. Utilizes get_header, and calls either lwgraph or linegraph.

Public Sub Fill _output grid age

-very similar to the above procedure, taking in the same things, but outputting numbers in
terms of year classes, for example, yearlings and 2 year olds. Also contains its own
plotting code.

Public Sub getseasoninfo

-takes in information concerning the working database along with component numbers
and start day. Extracts and sets to local variables the information contained in the
“Season Data” field.

Public Function get_date
-takes in julian day number alone with the start year to return date information in the
form of “15 Apr” instead of sometimes confusing julian day numbers.

Public Sub linegraph
-called from the Public Sub Fill_output grid to produce line plots representing totals.
Takes in data array and array of totals and the start year.

Public Sub lwgraph

-called from the Public Sub Fill_output grid to produce plots representing individual
component data in the form of lines, receiving a data array, and number of stocked and
wild components.

Public Function get _header

-sets up the header structure for the report format depending on the number of stocked
and wild components. Used when the Totals option is selected.
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Public Sub Proc _save data
-sub that coordinates the saving of output that is created by the model, storing the values
in a Notepad file.

Public Function get_total
-procedure for summing the total of a given data array.

Public Function get _header _age
-sets up the header structure for the report format depending on the number of stocked
and wild components. Used when the Year Classes option is selected.

Public Sub get biomass
-determines the daily biomass values by summing all components and finds the season
high biomass, displaying it in a text box in the upper right hand corner.

Public Sub Proc Read db _new

-this sub reads all the data from the imported Access files and saves them in locally
accessible arrays, usually according to component and month or year, depending on what
data it is using.
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Frequently Asked Questions

Q:

How do I force the program to make predictions for “no kill” managed
areas?

Enter 1000 for the size limit. The program recognizes this value and will set the
probability of legal catch equal to O for all days of the season.

How can | be sure that the data | modified on the data window are used
in calculations?

After you have changed the data in the data window make sure you click on a new
cell or change the topic heading (by using the drop-down menu) thus saving the
entered data. If you see a pencil icon in the row label on the lefthand side of the
form, then the data is not been saved. Make sure there is a triangle symbol, »
signifying your data is saved before you run your predictions. Note that when you
save the changes made to the data in the data window the changes are also saved
in the Access database.
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Appendix I: Stream Classification Key

Source: Engstrom-Heg, R. 1990 page 5

Bw

Bs

Bp

Aw

Aw9

Aw10

Awp

As

As9

As10,

Asp

Infertile or habitat-deficient wild trout streams lacking significant unused carrying
capacity. Not stocked

Infertile or habitat-deficient streams, often small, with significant unused carrying
capacity and a light-to-moderate fishery. Stocking provides for an early-season
fishery and some holdover.

Put-and-take streams characterized by a moderate-to-heavy fishery, and relatively
little potential for wild and holdover contribution.

Productive wild trout streams with light to moderate fisheries. Not Stocked. No
size limit.

Wild trout stream managed under a 9 inch limit

Special regulation areas based on wild populations, with a 10 inch, 3 fish, artificials-
only regulation.

Heavily fished wild trout streams lacking significant unused carrying capacity, and
inappropriate for a size limit. Wild population is supplemented by stocking of put-
and-take fish to provide for the early season fishery.

Stocked streams with no length limit, having significant unused carrying capacity
and a light to moderate fishery. Stocked with put-grow-take fish, usually two
increments.

Stocked streams managed under a 9 inch length limit, typically the larger, more
productive, more heavily fished streams, characterized by superior growth and
survival.

12, 14, and NK
Special length regulation areas based primarily on stocked trout.

Heavily fished stocked streams of good quality, with significant holdover, but not
managed under a length limit. The early season fishery is provided for by a
combination of put-and-take fish and holdover fish from a late spring stocking
during the previous spring.
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